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100 Questions

Que. 1 What day of the week was on 15th April 1800?

Correct Option - 1

Tuesday1.
Thursday2.
Wednesday3.
Saturday4.

Que. 2 Select the option which is related to the third term in the same way as the second term is related to
the first term.

26 : 649 : : 34 : ? 

Correct Option - 2

1221  1.
11212.
10243.
13314.

Que. 3 Select the option which is related to the third term in the same way as the second term is related to
the first term

DEA : FFZ :: HIW : ?

Correct Option - 3

HHK1.
ILL2.
JJV3.
IJK4.

Que. 4 Identify the number pair which is different from the rest of the alternatives.

Correct Option - 2

2392 × 691.
7323 × 762.
3223 × 633.
6234 × 984.

Que. 5 Select the number that will come in place of the question mark in the following number series.
3, 13, 61, 241, 721, 1441, ?

Correct Option - 4

27561.
14042.
28823.
14414.

Que. 6



According to the President (Discharge of Functions) Act, 1969, which of the following option is applicable
when the President or the Vice-President is not available or is dead?

Correct Option - 3

The Prime Minister can be appointed as the President by the Chief Justice.1.
The President can be appointed by the Council of Ministers.2.
The Chief Justice or a senior judge can discharge the functions of the President.3.
If need be, the President can also take over the functions of the Prime Minister.4.

Que. 7 Which empire of India was captured by the British in 1849 after a decade of successful war?

Correct Option - 2

Awadh Empire1.
Sikh Empire2.
Mysore Empire3.
Maratha Empire4.

Que. 8 Why did NASA abandon efforts to revive Mars rover Opportunity in 2019?

Correct Option - 3

'Opportunity' did not land in a crater, so no view was available1.
Cameras getting useless due to poor lighting2.
Solar power was not available due to dust storm3.
Contact with earth was lost4.

Que. 9 Which sector in India is facing the most 'crisis' since 2015?

Correct Option - 4

Information technology industry1.
Food Processing and Agricultural Products2.
Metal processing industry3.
Agriculture and allied work4.

Que. 10 In which sport did Karnam Malleswari won the bronze medal in the 2000 Olympics?

Correct Option - 3

Boxing1.
Archery2.
Weight lifting 3.
Swimming4.

Que. 11 Select the most appropriate ANTONYM of the given word.
REPULSIVE

Correct Option - 2

obstinate1.
attractive2.
assertive3.
offensive4.



Que. 12 Select the INCORRECTLY spelt word.

Correct Option - 2

hypocrisy1.
heriditory2.
hindrance3.
harass4.

Que. 13 Select the most appropriate synonym of the given word.
INGENIOUS

Correct Option - 4

incompetent1.
awkward2.
ignorant3.
resourceful4.

Que. 14 The following sentence has been divided into four parts. One of the parts contains an error. Identify
the part that has an error.

Only one / of the students / have submitted / the survey report.

Correct Option - 4

the survey report1.
Only one2.
of the students3.
have submitted4.

Que. 15 Select the option that can substitute the underlined part of the given sentence. If no substitution is
needed, select 'No improvement required'.

The doctor said that he had been died from cholera.

Correct Option - 2

has died from1.
had died of2.
had been dead of3.
was dead by4.

Que. 16 The ______ allows users to perform the basic functions of a computer. It manages all software and
peripheral hardware, and accesses the central processing unit (CPU) for memory or storage

purposes.

Correct Option - 1

Operating System software1.
Application Software2.
Utility Programs3.
System Software4.

Que. 17 The _______ of Microsoft Word allows you to control the margins of your page, set tabs and
indentation of paragraphs. This is especially useful for managing images, text, and other elements.

ruler1.



Correct Option - 1

toolbar2.
task pane3.
outline view4.

Que. 18 What is common between Bing, DuckDuckGo and Google?

Correct Option - 1

These are search engines1.
They are applets2.
They are web browsers3.
They are ISPs4.

Que. 19 Which of the following option is not a proper conduct of internet/email?

Correct Option - 1

writing the entire message using only capital letters1.
To think carefully before clicking 'Reply to all'2.
Incorporating a clear, direct subject line3.
proofreading each message4.

Que. 20 In a Microsoft Excel worksheet:
i) Cells A1 and A2 contain 6 and 4 respectively.

ii) Cells B1 and B2 contain 3 and 2 respectively.
iii) Cell A3 contains the formula =$A$1 + A2.
iv) The formula in cell A3 is copied to cell B3.
The value displayed in cell B3 will be _____.

Correct Option - 2

91.
82.
63.
74.

Que. 21 Which of the following statement is not true about Twitter?

Correct Option - 4

People who follow you are called your followers1.
The Twitter users followed by you are the people or businesses whose updates you subscribe to2.
There is no limit to the number of accounts you can follow.3.
A request can be sent on twitter for other people to follow you on Twitter.4.

Que. 22 To share a Google doc with others, click on:

Correct Option - 4

Edit > Share1.
Tools > Share2.
View > Share3.
File > Share4.



Que. 23 For renaming a file in Windows, you will most likely use:

Correct Option - 1

File Explorer1.
File Manager2.
File Directory3.
File Folder4.

Que. 24 In which of the following applications/platforms, the “Skills and Support” section can be found?

Correct Option - 2

Pinterest1.
LinkedIn2.
Facebook3.
Twitter4.

Que. 25 Which of the following is the correct option to make the selected text bold?

Correct Option - 3

Ctrl + A1.
Ctrl + C2.
Ctrl + B3.
Ctrl + X4.

Que. 26 The full form of NPOP is:

Correct Option - 3

National Programme for Organic Processing1.
National Programme for Organic Products2.
National Program for Organic Production3.
Nodal Program for Organic Production4.

Que. 27 BIS is a statutory organization which came into existence on:

Correct Option - 2

1 April 19771.
1 April 19872.
1 April 19523.
1 April 19474.

Que. 28 As per the FSS Act, the sale of certain mixtures is prohibited. Which of the following is included in
this?

Correct Option - 2

condensed milk1.
water mixed milk2.
curd made from pasteurized milk3.
coffee and chicory Blend4.

Que. 29 EIC is a certification body of India which ensures:



Correct Option - 4

Quality products exported within India1.
Quality and safety of products exported outside India2.
Safe products exported within India.3.
Quality and safety of products exported from India4.

Que. 30 Flavored tea will be sold by only those manufacturers who are registered with _____.

Correct Option - 1

tea board1.
FSSAI2.
FSSA3.
brooke bond4.

Que. 31 International Organization for Standardization is:

Correct Option - 3

A Governmental organization1.
A national organization2.
A Non-governmental organization3.
Dependent on government4.

Que. 32 The primary function of the Spices Board includes:

Correct Option - 1

Production and development of small and large cardamom1.
Production and development of cloves2.
Production and development of cinnamon3.
Production and development of star anise4.

Que. 33 Agreement on Technical Barriers to Trade applies to:

Correct Option - 4

Only food products1.
Phytosanitary measures2.
Sanitary measures3.
All commodities, not just food4.

Que. 34 What of the following are included in the specific requirements for the labeling of alcoholic
beverages?

Correct Option - 2

health claims1.
alcohol content declaration2.
nutritional facts3.
nutritional information4.

Que. 35 The Marine Products Export Development Authority is a statutory body functioning under the
Department of

Social science1.



Correct Option - 4

Arts2.
Science3.
Commerce4.

Que. 36 Codex alimentarius standards are used by:

Correct Option - 2

Government to protect consumer’s health and ensure fair practices in the food trade1.
Codex members to protect consumer's health and ensure fair practices in the food trade2.
Members of public to protect health and ensure fair practices in the food trade3.
Food manufacturers to promote food trade4.

Que. 37 According to the FSS Act, the full form of COA is:

Correct Option - 3

Certificate of Approval1.
Certificate of Authority2.
Certificate of Analysis3.
Certificate of Assessment4.

Que. 38 Agricultural and Processed Food Products Export Development Authority has its headquarters at:

Correct Option - 1

New Delhi1.
Hyderabad2.
Chennai3.
Kochi4.

Que. 39 EIC Certification for food items like fish, meat, dairy and honey are:

Correct Option - 2

Not obligatory1.
Mandatory2.
Voluntary3.
Optional4.

Que. 40 Committee that evaluate food additives, contaminants, naturally occurring toxicants and residues of
veterinary drugs in food is called as

Correct Option - 1

JECFA1.
MRA2.
JEMRA3.
JMPR4.

Que. 41 As per the implementation of FSS Rules, 2016, FBOs are directed to use certain ingredients in their
products as normal products without claiming any health benefits. What do these include?

Salvia hispanica1.
Polypodium leucotomos2.



Correct Option - 1

Ipriflavone3.
PABA4.

Que. 42 The logo found on an organic product is called:

Correct Option - 1

Jaivik Bharat1.
NPOP2.
LoQ3.
PGS-India4.

Que. 43 Production development of small and large cardamom is the primary function of:

Correct Option - 4

Coffee board1.
Cardamom board2.
Rubber board3.
Spice Board4.

Que. 44 FSS Regulations on Health Supplements, 2016 and Nutraceuticals prohibit

Correct Option - 3

vegetable special food1.
plant food2.
psychotropic substances3.
food for special medical purposes4.

Que. 45 EIC is headed by the

Correct Option - 3

President1.
EIC council2.
Chairman3.
Director4.

Que. 46 Which of the following are the types of certificates granted by EIC for various products like fish,
dairy, meat, poultry etc.?

Correct Option - 3

optional1.
non binding2.
essential3.
voluntary4.

Que. 47 The vertical issues of FSS Act includes:
Functional foods1.

Food Additives2.
Water, flavored water and beverages3.



Correct Option - 3
Genetically modified organisms and foods4.

Que. 48 As per the implementation of FSS Regulations, 2016, FBOs are directed to immediately withdraw
such products from the market which contain ingredients like _____.

Correct Option - 2

Artichoke1.
Vanadium2.
Kale powder3.
Broccoli Enzymes4.

Que. 49 The FSS Act prohibits the sale of certain products. What does this include?

Correct Option - 3

Mushrooms1.
Broccoli2.
Carbide gas in fruit ripening3.
fresh fruits and vegetables4.

Que. 50 The sale of common salt is prohibited unless it is:

Correct Option - 3

free flowing1.
bulk powder2.
iodized3.
powder4.

Que. 51 How can the lack of label on imported packaged food consignment be rectified in the custom
bound warehouse?

Correct Option - 2

Submission of certificate for proprietary food with category or sub-category with common name,
nature and composition

1.

Attaching a non-detachable sticker to the main display panel2.
by affixing a detachable sticker with the required details3.
Submission of certificate with logo and license number of Food Safety and Standards Authority of
India

4.

Que. 52 The basic level of food safety training and certification programs is designed for

Correct Option - 4

high risk food business1.
State Licensed Food Business2.
Central Licensed Food Business3.
food business4.

Que. 53 As per the government regulations and recommendations, mandatory standards concerning the
composition, quality, inspection, and labeling of specific food products include:

ISO 22000:20051.



Correct Option - 4

Standards of Grade2.
ISO 220003.
Standards of Quality4.

Que. 54 The All India Cyclothon called 'Swasth Bharat Yatra', a key element of the 'Eat Right India
Movement', was flagged off on:

Correct Option - 4

May 16, 20181.
January 16, 20182.
March 16, 20183.
October 16, 20184.

Que. 55 For fortified food, using the tag line 'Whole Nutrition Healthy Living' below the logo is:

Correct Option - 2

mandatory1.
optional2.
binding3.
essential4.

Que. 56 Vanaspati with added vitamin A can:

Correct Option - 3

Be promoted using +F logo1.
Be claimed as 'fortified' or use +F logo for its promotion2.
Not be claimed as 'fortified' or use +F logo for its promotion3.
Be claimed as 'fortified'4.

Que. 57 FMCG Stands for ?

Correct Option - 1

Fast-moving consumer goods1.
Fruit and meat consumer grade2.
Fast-moving customer goods3.
Fruit and meat consumer goods4.

Que. 58 A portal that allows a consumer to share their concerns, know their rights, authenticate the
license/registration certificate of food business operators, etc., is called?

Correct Option - 4

FoSCoRIS1.
FSS2.
FLRS3.
Food safety connect4.

Que. 59 The high risk food business or the food business which require special attention include:
Storage & Transport1.

Manufacturing/Processing2.



Correct Option - 4

Catering3.
Milk & Milk Products4.

Que. 60 A fruit pulp is defined as:

Correct Option - 1

Edible part of the whole fruit, which may be sliced or crushed but not reduced to a puree.1.
Edible part of the whole fruit which is pureed2.
Edible part of the whole fruit, which may be sliced or crushed or pureed3.
Edible part of the whole fruit4.

Que. 61 Meat Food Products Order 1973 was promoted under the act:

Correct Option - 3

Right to Food Act1.
Essential Service Maintenance Act2.
Essential Commodities Act, 19553.
Consumer Protection Act, 19864.

Que. 62 Maharashtra Agro Industries Development Corporation Ltd promotes:

Correct Option - 4

Modernization of the Agro sector by inventing quality pesticides1.
High quality fertilizers2.
High quality seeds3.
Modernization of the Agro sector via mechanization4.

Que. 63 Where is the Central AGMARK Laboratory situated?

Correct Option - 3

Pune1.
Bengaluru2.
Nagpur3.
Lucknow4.

Que. 64 What is the extension of 'FoSCoRIS'?

Correct Option - 3

Food Safety Commission via Regular Inspection and Sampling1.
Food Survey Compliance via Regular Inspection and Sampling2.
Food Safety Compliance through Regular Inspection and Sampling3.
Food Safety conformity via Regular inspections and sampling4.

Que. 65 What is the condition of salt fortified with iodine as per FSS Regulations, 2018?
Mandatory to be claimed as fortified1.

Use of +F logo is mandatory2.
Exempt from the use of the +F logo3.
It is mandatory to use fortified and +F logo4.



Correct Option - 3

Que. 66 What is the full form of AGMARK ?

Correct Option - 1

Agricultural Mark1.
Agricultural Produce (Grading and Marketing) Act2.
Agricultural Certificate3.
Agriculture Marking Act4.

Que. 67 What was the drawing inspiration for the Swasth Bharat Yatra, which is part of the Eat Right India
campaign?

Correct Option - 2

Swachh Bharat1.
Mahatma Gandhi's Salt March2.
Jago Bharat Jago3.
Ayushman Bharat Scheme4.

Que. 68 What is the full form of FosTaC?

Correct Option - 2

Food Safety Training and Commission1.
Food Safety Training and Certification2.
Food Safety Trading and Certification3.
Food Safety Trading and Commission4.

Que. 69 As per the government regulations and recommendations, voluntary standards concerning the
composition, quality, inspection, and labeling of specific food products include:

Correct Option - 4

Standards of Quality1.
Standards of Fill-of-Container2.
Standards of Identity3.
Standards of Grade4.

Que. 70 As per the FSS (Packaging and Labelling) Regulations, 2011, the bottle should be sealed in such a
way that:

Correct Option - 2

it can be opened without destroying the license number displayed on the top or neck of the bottle 1.
It cannot be opened without destroying the license number displayed on the top or neck of the bottle2.
The seal can be opened after peeling off the license number displayed on the top or neck of the bottle3.
The license number is printed on the neck of the bottle4.

Que. 71 A person of rank _____________ should be in the post of Chairperson of the Food Safety and
Standards Act, 2006.

Secretary to Chief Minister1.
Minister of Legislative Assembly2.
Secretary to the President3.



Correct Option - 4
Secretary to the Government of India4.

Que. 72 Special course in food safety training and certification programs is created for:

Correct Option - 4

State & Central Licensed food business1.
Central Licensed food business2.
Food business3.
High risk food business or those business requiring special attention4.

Que. 73 What is the EEE strategy implemented by FSSAI to promote RUCO?

Correct Option - 4

Education Enforcement Environment1.
Education Enforcement Ecological unit2.
Edification Enforcement Ecosystem3.
Education Enforcement Ecosystem4.

Que. 74 The first city in India to be accorded the CSFH tag by FSSAI in 2008 is:

Correct Option - 3

Delhi1.
Mysore2.
Ahmedabad3.
Bangalore4.

Que. 75 'Meat' is defined as:

Correct Option - 3

Dried meat1.
Processed meat2.
Flesh and other edible parts of a carcass3.
Cured meat4.

Que. 76 The category of cholesterol which is also referred to as 'good cholesterol' is:

Correct Option - 3

HDL:LDL1.
LDL2.
HDL3.
VLDL4.

Que. 77 Time (in min) at specified temperature required to destroy 90% of the cells at the respective
microbial population is called as:

Z-value1.
D-value2.
F-value3.
T-value4.



Correct Option - 2

Que. 78 Food is preserved by producing a shock wave that inactivates micro-organisms. What is this
method of preservation called?

Correct Option - 4

vacuum packaging1.
controlled environment2.
gas packaging3.
Pulsed Electric Field4.

Que. 79 At a specific temperature, the number of minutes required to destroy the desired number of cells of
any microbe is

Correct Option - 4

T-value1.
D-value2.
Z-value3.
F-value4.

Que. 80 Time of heating required to kill all vegetative cells of microorganisms is called:

Correct Option - 4

logarithmic order of death1.
Kinetics of heat destruction2.
Bacterial destruction rate3.
Thermal death time4.

Que. 81 Proteins that act like catalyst for some biochemical reaction is called as:

Correct Option - 2

Hormones1.
Enzymes2.
Proteins3.
Lipids4.

Que. 82 Water activity (aw) is closely related to

Correct Option - 1

relative humidity1.
moisture2.
water content3.
humidity4.

Que. 83 Chili powder is usually adulterated with

Correct Option - 1

saw dust1.
color and saccharin2.
Kesari Dal3.
aluminum foil4.



Que. 84 The two main components of GMPs essential for the success of the food safety system are:

Correct Option - 3

Education and accomplishment1.
Education and enforcement2.
Written programs and implementation3.
Manual and accomplishment4.

Que. 85 The other name for 'pre-requisite programs' is

Correct Option - 4

Written programs1.
Implementation2.
HACCP3.
Good Manufacturing Practices4.

Que. 86 The highest level of energy per gram is provided by

Correct Option - 2

carbohydrate1.
fat2.
protein3.
fiber4.

Que. 87 What is the most common food preservation method?

Correct Option - 3

freezing1.
fermentation2.
heating3.
freeze drying4.

Que. 88 Protein is essential

Correct Option - 1

to maintain proper fluid regulation1.
To add fiber to the diet2.
for brain work3.
to provide instant energy4.

Que. 89 Organic acids used in food preservation include:

Correct Option - 4

Sulphuric acid1.
Boric acid2.
Hydrochloric acid3.
Sorbic acid4.

Que. 90 Thermobacteriology is a relationship between:



Correct Option - 2

Heat and virus1.
Heat and bacteria2.
Heat and microorganisms3.
Heat resistant bacteria and thermodynamics4.

Que. 91 Non-acidic foods have a pH range of

Correct Option - 4

5.3 - 4.61.
4.6 - 3.72.
< 3.73.
7.0 - 5.34.

Que. 92 Risk for coronary heart disease may increase with high intakes of:

Correct Option - 4

Coconut oil1.
Coconut2.
Red palm oil3.
Animal fats4.

Que. 93 Number of degree required to pass through one log cycle is called as

Correct Option - 1

Z-value1.
D-value2.
F-value3.
T-value4.

Que. 94 Minimum water activity required for some yeasts and molds to grow is

Correct Option - 2

1.001.
0.652.
1.503.
2.004.

Que. 95 The basic operational and environmental conditions applied to produce safe foods are called:

Correct Option - 4

HACCP1.
FSSA2.
FSSAI3.
Good manufacturing Practices4.

Que. 96 Cheddar cheese is manufactured using lipases extracted from:
Aspergillus niger1.

Lamb pre-gastic lipase2.



Correct Option - 1

Kid pre-gastric lipase3.
Penicillium camemberti4.

Que. 97 What are the characteristics of glass?

Correct Option - 4

Made from recycled paper and often contains impurities and impurities1.
Acid treated pulp2.
The strongest of all the papers commonly used for bags and wrapping3.
Greaseproof, very dense sheet with a very smooth and glossy finish.4.

Que. 98 What is made by heating a mixture of silica, sodium carbonate and limestone at high temperature?

Correct Option - 1

glass1.
plastic2.
laminates3.
aluminum foil4.

Que. 99 Two unsaturated fatty acids are also called as "essential fatty acids" because:

Correct Option - 2

They can be produced by the body as well as supplied from the diet.1.
The body cannot produce therefore it becomes essential that we get them from the food we eat.2.
The body cannot produce in sufficient amounts therefore it should be supplied from the diet3.
They are produced by the body4.

Que. 100 What is the exo-acting enzyme called that catalyzes the hydrolysis of polysaccharide starch to
release β-glucose?

Correct Option - 2

cellulase1.
glucoamylases2.
β - amylase3.
α - amylase4.
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